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Overview

Login and Access

Access to functions within the application is restricted based on roles. Which roles you have is determined
by your Education Sector Login (a.k.a. ESAA) set-up, according to the roles your organisation has granted
you.

For a full list of roles and access rights see: Appendix A: Access Rights

Log in to the external moderation application

I. Log in to the NZQA Schools & TEOs Login (https://www.nzga.govt.nz/login/), using your usual
Education Sector logon details.

2. Select the External Moderation link from the Moderation section.

Moderation

External Moderation

Assessment and Moderation Plans, Moderation
Reports and Annual Summaries for NZQA moderated
standards.

3. The landing page of the application displays. You can now navigate to the appropriate part of the
application.

Welcome to NZQA Moderation

Assessment Plan

Moderaton
Vioderation

Moderation History

‘Training and support material

e NZQA Logo - click on the logo or the Home symbol to return to the landing page from anywhere
in the application.

e Menu Buttons — provide access to different parts of the application.
The buttons available are dependent on your access.

e User Profile — click here to logout.
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Navigation

The following functions are accessible from the landing page:

w
=
=
o
=

Description

View your current Assessment Plan, select standards, and submit your
plan.

Assessment Plan

See: Assessment Plan section for more details.

Modorstion View moderation plans for the current and previous (or next cycle),
prepare moderation submissions, view reports, and submit queries and
appeals for moderation reports.

See: Moderation Plan, Make a Moderation Submission, Moderation
Reports and Appeals sections for more details.

View moderation results and reports for the previous five years (from
2017 onwards). Results prior to 2017 are available via the Historical
moderation link

Moderation History

See: Moderation History section for more details.

View the current annual summary, any related action plan, and access
historical summaries.

Annual Summarnes

See: Annual Summary section for more details

. . Training materials and guides for the External Moderation application.
Training and support material

Notifications

The application will notify you of outcomes or of tasks you need to complete. For example, you will receive
an email when your assessment plan is ready to access, or a reminder to submit materials for moderation.

Only the person recorded with NZQA as the moderation contact will receive notifications from the External
Moderation Application, i.e.:

e Schools: Principal’'s Nominee
o TEOs: Moderation Liaison

Notifications will be sent to the email address held by NZQA for the moderation contact. If you want us to
send the notifications to a different email address, you’ll need to update your preferred email address in
NZQA'’s School &TEO Login.

This information may take up to 48 hours to update the application.

Note: The person preparing a submission can enter their email address to receive a notification when the
moderation report is available - see no.8 p.24
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Common Features

Tables

Wherever information is presented in a tabular form in the application there is a common set of features.
These features are available on the following pages:

e Assessment Plan
e Moderation Plan
¢ Moderation History

TABLE OPTIONS

The options available on the table views are:

Actions v View v [l Excel ) CSV () Print ™ = Detach

Some options may not be available on some tables.

Menu Iltem Description
Actions Menu | Drop-down to access actions specific to the External Moderation application.
E.g.: Submit Standard, View Report. Action menu is also accessible by ‘right-clicking’
on a selected standard.
Available on the Moderation Plan and Moderation History pages.
View Menu Drop-down list of actions which can be used to customise the table view.
— Export the data displayed in the table as an excel file.
= Export the data displayed in the table in .csv format.
) €SV
= Print Creates a printable view of the current screen. Use your browser print option (or Ctrl-
- P) to print the view. Only prints what is visible on the view.
= | Clears any duplicate columns (sometimes occurs when manually re-ordering).
. DO NOT use refresh on a ‘detached’ window — the application will freeze.
Refresh:
Filter the data in the view.
Filter:
-] Detach Opens the current view ‘full screen’ in a separate window. All options (except Refresh)
are available in the detached view.
Expand: >> | Under some circumstances the menu may shrink and not all icons are visible. Click on
the expand icon (>>) to access them.

29-Aug-2018
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FILTER TABLES
Use the Filter option to quickly find an item of interest e.g. a standard.

Apply a Filter

I. Enter the filter criteria in the field above the column you want to filter on.
2. Press Enter, (on your keyboard) to apply the filter.
3. Example: filter Assessment Plan by Standard Title:

Use the filter fields to refine the list of
standards.The * character can replace one or

more characters.
Business S

*market “C
Standard . Date Materials
Mabhar Standard Title Level Selection Available
90840 Apply the marketing mix to a new or existing product 1 0 o
9084¢ Conduct market research for a new or existing product 2 0 ©
91382 Develop a marketing plan for a new or existing product 3 0 )
To find ... Then...

a specific standard Enter the full standard number in the Standard Number field.

a range of standards | If the standards begin with the same series of numbers, type the common
numbers followed by an asterisk in the Standard Number filter field.

Example: 9084 will display standards: 90840, 90841, 90842, etc

standards that Enter the word in the Standard Title filter field, or

Svc;r;:cjaln a specific Use wildcards to find ‘like’ words: e.g. *market in the Title field will display any
standards that contain words like market, markets, marketing, supermarket.

all standards for a Enter the level number in the Level filter field.

level

all ‘selected’ Enter ‘T’ in the Selection filter field (Assessment Plan only).

standards

Remove a Filter

A filter, will apply until you change or remove it, even if you open another system.
To remove the filter — just delete the text entered in the filter field(s) and press Enter key.
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EXPORT DATA FROM A TABLE

You can export any data that is displayed in a table in the application.

The export is dependent on what view you are in, i.e.:

e Assessment Plan:
o Summary table - the list of systems, and number of standards selected.
o By ‘Select Standards’ — all standards on the plan.
o By System — all standards for that system.

¢ Moderation Plan — all standards on the plan.

¢ Moderation History — historical outcomes for completed reports (2017 onwards).

If you have customised your view, then the exported data will reflect that customisation.

Data can be exported in Excel (.xIs) or CSV formats.

Export to Excel

To export a plan to Excel: Opening Tararua College-2019-1900814 - Assessment Plan.xls ﬂ‘

I. Select the Excel icon. Yot have choaen 10 0pen

B Tararua College-2019-1900814 - Assessment Plan.xls

2 A Conflrmatlon pOp-Up WI" dlsplay which is: Microsoft Excel 97-2003 Worksheet

Note: the pop-up does not always come to the from: hitps:/inzqaustnew.contentwonx.co.nz
front of the screen — if it doesn’t you can find it by i F e
tabbing through your open windows (Alt-Tab, on @ Open with [ Microsoft Excel (defaut) vl
the keyboard). Save Fie
3. Choose the ‘Open with’ option. Do this automatically for files like this from now on
4. Check the application is set to Excel — or select it
from the drop-down. | | Cancel
5. Select Ok to confirm. )

6. Excel will start (if not already open) and a
warning message may appear — select Yes to continue.

Microsoft Excel ==

The file format and extension of ‘Tararua College-2019-1900614 - Assessment Plan-L.xls’ don't match, The file could be corrupted or unsafe, Unless you trust its source, don't open it. Do you

B\ wantto open it anyway?
<[T” Ne | | Hep

7. Excel will open with the exported data in the worksheet.
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Export to CSV

Use this format if your spreadsheet application is not Opening Tararua College-2019-1900814 - Assessment Plan.csy SRS
Excel.

You have chosen to open:

. ¢ Tararua College-2019-1900814 - Assessment Plan.csv
To export the plan in CSV format. D T R

. from: https://nzqauatnew.contentworx.co.nz
I. Select the CSV icon. What should Firefox do with this file?

Qpen with | Google Chrome (defaut) v)

2. A confirmation pop-up will display: ' l

[] Do this automatically for files like this from now on.

3. Choose the ‘Save File’ option and select OK to

confirm. o

4. Open the file from your saved downloads (the
location is dependent on the browser you use).

G aran e n iy masessmer o -
€ e PSS —— - - =
Core swtts

Drama1 4

Eanty Chilanood Educaton and Care (PIECE)
Engiish

Geography

Hean Ecucaton

Shwer al Faie atnn
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VIEW TABLE IN FULL SCREEN

Detached View

Detach the table to view in ‘full screen’.

1068
1604

1575
1418

“ 6w e e -

1601
2752

1633

1431
1437

0020

Standard Title

Undertake devesopment of design eas through grap.

Technology - Design and Vis.

howan
Demonsirate understanang of the tasting nfiuences
Apply trigonometric methods in soiving problems.
Demonsirate ensemble sKits by performing two sudst
Carry out a practal mvestigaton m a bologeal cont
Demonsirate knowledge and sk of performance <o
Demonsirate knowiedge of twaewae
procedures o

Demonstrate knowtedge of practices and strategies |
Examine personal mvoivement n 2 sacial Action(s)
Analyse aspects of a contemporary geographic issue
Analyse afferent perspectves of a contested event o
Contribute within  feam or group which has an object

Classical Studes.
Mathematcs 1-4

Music 14

Biology (Human Biology)
Maori Performing Afts

Mau Rakau

Technology - Digtal Technol
Home Economics

Social Stuses

Geograghy

History

Core Skis

Describe personal and nygiene and sa

Eany C! a

Submitted Date

24-0c1-2017
24012017
240012017
240012017
240012017
25-0c1-2017
26-0c1-2017
26-01-2017
240012017
24-0c1-:2017

01-0v-2017

27-0c1-2017

Report (Due) Date

26-0ct:2017
26-0ct-2017
26-0ct:2017
26-0ct:2017
26-0c1:2017
27-0c1:2017
27-0ct:2017

02-40v-2017

Close detached table #

Outcome

Report - Pending Matenal
Report - Final

Report - Fnat
Report - Final

Report - Fnat
Repot - Fnal (Appeal)
Report - Fnal
Repot - Finat
Submession - Sutimitted

Submission - in Progress.

&

Page 2

of § (18-30 of 84 items)

K(134E-)>i

To return to the main
view click on the X.

Detaching the table does not increase the number of rows visible — you will still need to use the page
navigation if you have more than 15 standards on your plan.

Notes

o All the table options are available in the detached view.

e DO NOT ‘refresh’ a detached table — it will cause the screen to freeze.

29-Aug-2018
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CUSTOMIZE A TABLE

You can customise your view of the Assessment or Moderation plan, or Moderation History view including:
¢ which columns to display

e the order of the columns

e the sort order.

Any changes you make will be saved when you exit the application. The changes are specific to your view
and do not affect any other users.

Example: Moderation Plan View

You may find it helpful to tailor the moderation plan view according to where you are in the moderation
cycle:

Actions v View v @@ Excel ] CSV (S Print ,‘f {&| Detach

fe
Standard Submis§ Date Mat. | Submitted

English 1 90052 Produce creativ. Digital 06-Sep-2019 Consistent Report - Provisional

Social Studies 2 91280 Conduct a reflec... Physical Submission - Ready to Submit
French 5 91547 Wite a variety 0... Physical 17-Sep-2019 Submission - Submitted

Maori Performing Aris 3 22756 Perform a Maori. . Submission - Not Started
Visual Arts 1-4 3 91445 Use drawing to . Digital Submission - Ready to Submit
Media Studies/Journalism 1 90990 Demonstrate un... Physical Submission - In Progress
Core Skills 2 9677 Communicate in_ Submission - Not Started
Drama 1-4 2 91220 Script a scene s... Physical 08-Jul-2019 Report - In Progress

Dance 1-4 3 91593 Demonstrate un... Submission - Not Started
Science 1-3 il 90950 Investigate biolo... Physical Submission - Ready to Submit
Te Reo Maori 1-8 2 91285 Korero kia whak . Digital Submission - Not Started
Visual Arts 1-4 3 91451 Systematically c... Digital Submission - Ready to Submit
Chemistry B 91393 Demonstrate un... Digital Submission - Ready to Submit
Accounting 2 91179 Demonstrate un... Physical 13-Sep-2019 Report - Pending Material
Physical Education 24 91329 Demonstrate un... Physical 16-Sep-2019 Report - Pending Material

Page 2 of3 (16300f45fems) K < 13 >

Choose which columns to display

To choose which columns to display:

Actions v NCURA [ Excel ) CSV (3 Print ¥ « Detach
I. Select View > Columns from the menu. e o
2. Tick or un-tick column names, as Detach v Standard Number S
. ] UDMISSIO
required. sont » v Standard Tite Type
3. Only ticked columns will display. SONE—— e
91230
91257 S Digital
v Date Mat. Available
. . 28094 Produceah... 2 Digital
Note: the columns available will depend on p— o | v Submssion Tpe Dg't |
the view. This example is for the Moderation S , cuomedDus [l
Pl 91601 Carry out a 3 Digital
an. v Outcome
91330 Performap... 2 Digital
v Status
90956 Demonstrat 1 . Digital
o v RAS Pilot -
91264 Use statistic... 2 . Digital
91500 Evaluate the... 3 Manage Columns . Digital
91155 Demonstrat... 2 Biology (/Hu... 17-D... Digital
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Change column order

To change the order of the columns:

I. Select View > Reorder Columns from the menu.

Actions v RV €13 Excel 2) CSV

Detach
Standa
Stand4
Num ¢ Sort >
91633 omplex procedul
l

te knowledge of ¢

90959 v Query by Example
91431 3 Analyse aspects of a conten
9681 3 Contribute within a team or ¢

2.

3.

4. Repeat for any other columns.

5. Select OK to save the new order.
Notes:

e Only columns selected to display (see above) will be listed in the Reorder Columns pop-up’

I Reorder Columns |

Visible Columns

NZQA Mod. Syst:

Level

Standard Title
Status
Submission Type

Submitted Date

em

Standard Number

OK

-~

m

Cancel

Select the column name for the column you want to move.

Use the arrow keys to change the order of the selected column.

¢ The columns available will also depend on the view. This example is for the Moderation Plan.

e You can also reorder using the column headings (drag & drop). The table will revert to the default

order next time you log in.

29-Aug-2018
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Custom Sort the table

91633 Reorder Columns...
90959 v Query by Example
91431 3
9681 3

Contribute within a team or ¢

I. Select View > Sort from the menu.

Csv () Print

complex procedu
te knowledge of |
Analyse aspects of a conten

To create a custom sort order for the rows in the table:

Advanced Sort

Sort By
NZQA Mod. Syste*nv |

Then By

Level ‘ v‘

Then By
Standard Number ‘ ~ l

Ascending

Descending

Ascending

Descending

Ascending

Descending

OK  Cancel

Notes:

log in.

Actions v View v [l Excel

3. Add additional sorting levels as required.
4. Select OK to save the order.

)OSV (2 Print . Detach

Example: Moderation Plan sorted by: System > Level > Standard Number

2. Select the column title in the drop-down and the order (ascending or descending).

e You can also sort using the column headings. The table will revert to the default order next time you

Agricultural and Horticultural 90918 Carry out a practical agricultural or horticultural investi... 1 Submission - Not Started
Biology (/Human Biology) 91601 Carry out a practical investigation in a biological conte... 3 Report - Final (Appeal) Physical 25-Oct-2017
Biology (/Human Biology) 91604 Demonstrate understanding of how an animal maintal... 3 Report - Final Physical 24-0ct-2017
Blology (/Human Biology) 91607 D g of human p 0.3 Submission - Not Started
Chemistry 91388 D of sp: pic datainc... 3 Submission - Not Started
Classical Studies 91398 Demonstrate understanding of the lasting influences o... 3 Report - Final Physical 24-Oct-2017
Computing 1-4 2787 Create and use a computer database to provide asol... 3 Submission - Not Started
Core Skills 9681 Contribute within a team or group which has an objective 3 Submission - Not Started
Core Skills 28098 Evaluate options to increase personal income 3 Submission - Not Started
Drama 1-4 91513 Devise and perform a drama to realise a concept 3 Submission - Not Started
Drama 1-4 91519 Script a drama suitable for live performance 3 Submission - Not Started
Early Childhood Education an... 10020 Describe personal and environmental hygiene and saf... 2 Report - Final Physical 27-0ct-2017
English 90854 Form personal responses to independently read texts,... 1 Submission - Not Started
English 90855 Create a visual text 1 Report - Final Digital 24-Oct-2017
English 91101 Produce a selection of crafted and controlled writing 2 Submission - In Progress Digital
Page 1 of 3 (1-15 of 40 tems) [T| 218 . iy
il
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Download and Print

Moderation Reports and Annual Summaries can be downloaded for printing or electronic distribution.

Reports can be downloaded from the following pages:

¢ Moderation Report view
¢ Moderation Plan table
¢ Moderation History table.

Any person with access to the application can download/print a report.

Annual Summaries can be downloaded from the Annual Summary view. Only people with access to view

Annual summaries can download/print them.

PRINT

Print a single moderation report

I. Log in to the application and select
Moderation.

2. Click on the required standard.

3. Right-click to access the menu.

4. Select Print Report from the menu.

Adions v View v @@ Excel ) CSV ) Print ¥ ]

Y
Standard Date Mat. |Submissiq
1

90856

English

Detach

Digital

06-Mar-2018

91350
22756
27999
8998

91442
91537
91340

2 Technology y— Digital 06-Mar-2018
&3 Maori Performing A = Digital 06-Mar-2018
2 English Language 22 View Submissiod Physical 13-Nov-2017
2 Sociology (@ EdtSuomission  Cu+& Digital  06-Mar-2018
3 Visual Arts 1-4 8= YiewRepot  Cti+V Digital  06-Mar-2018
& Chinese Digital 06-Mar-2018
2 Technology - Design and Visual Co Digital 06-Mar-2018
0] Di

Print multiple moderation reports

¢ You can select up to 75 standards.

4. Select Print Report(s) from

the menu. Moderation History
ABC College (1234)

Adions w vieww Qi Excel  SCSV 0 Prim

Note: the download time is

dependent on the number and Cor il
size of the reports selected. o —

Physical Education 91602
Wiaori Performing Arts 2756

Te Reo Maori 1-6 91083
Te Reo Magri 1.8 91285
Tachnology - Design and Visusi Comm.. 91067

2. Ctrl-click to select multiple standards from the table:

3. Right-click on a selected standard to access the menu.

I. Log in to the application and select Moderation History.

e The reports will be generated as individual pdfs within a single zip file.

pou

Standard Number

Standard Title
Communicate with peaple flom other cultures.
Chereograph a dance 1o develop and resobve ideas

Demansirats understaading of the function of the body as it relates 10 the peria
\-_ 8 =

Waihianga tuhinga i te reo o tona 80
Korero kia whakemah i te reo o te a0 torotoro
Use the work of an infuential designer to inform design ideas

Assessor | Assessment
ik

Decisions Tas!
3 Consistent
3 Consistent
1 Cansistent

Cansistent

2 Cansistent
1 Consistent

Kaore and .. Kaare and .. Kaore and . 2017

29-Aug-2018
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To print an annual summary

I. Log in to the application and
select Annual Summaries

2. Select and View the required
summary.

3. Select Print/Download.

2018 External Moderation Summary
‘ABC College (1234)

Overall results for National External Moderation

ABC College

meets the majority of the national external moderation requirements for 2018

Overall Comment Overall Comment Overall Comment Overall Comment

A summary of all moderation results and access to individual reports for ABC College

13 Aug 2018
AMS-180104

Iis available on the Modsration Histary page.

BRI PrintDownload

DOWNLOAD FILES

Filenames

The print function creates a download file of the selected document(s) with the following naming

conventions:

e Single report: Moderation Subject Name — Standard Number — Year (.pdf)

e Multiple reports:

o creates a single zip file for ALL the selected reports: Reports — File Created Date — Year (.zip)

o individual reports within the zip file: Moderation Subject Name — Standard Number — Year (.pdf)

e Annual Summary: Year — Summary — School Number (.pdf)

Open Download Files

When the downloadabile file is created the result will
depend on your browser and personal set-up:

e a pop-up may open with options to save or open

the file

¢ the downloaded file link may appear somewhere

on the screen

o the file will also be accessible from your browser
download menu and/or the ‘downloads’ folder

on your device.

Comrrk
Jearcn

Reports_08_Mar_2018_01_41.zip

2.1 MB — contentwontco.nz — 1:43 PM

e

B Reports_08_Mar_2018_01_32.zip

w B8 ¥ &

rOp ening Reports_08_Mar_2018_01_41.zip
You have chosen to open:
Reports_08_Mar_2018_01_41.zip

which is: Compressed (zipped) Folder

from: https://nzqauatnew.contentworx.co.nz

What should Firefox do with this file?

Windows Explorer (default)

I (") Save File

Do this automatically for files like this frem now on.

¥ | [4 || = | Downloads
Kl o o e
« « 4 & » ThisPC » Downloads

% o Name

v Quick access

B Desktop
3 Downloads
= Bocuments

Cancel

™ Technology - Design and Visual Communication_81242_2018.pdf

29-Aug-2018
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Assessment Plan

Overview

An assessment plan for the next moderation cycle is released by early November each year.

You will receive an email notification when your plan is available, and a reminder to submit your plan prior
to the due date. Plans are due early December.

TEOs

Must select all the standards they are intending to assess and provide the earliest date that the learner
evidence will be available for moderation for each standard. TEOs are required to submit an assessment
plan if they have consent for NZQA managed standards.

Schools

Selection of standards and submission of a plan is optional for schools but provides a way to communicate
your preferences for moderation to NZQA. If you have no preference on what standards are moderated
within a system, then no selection is required for that system.

Where possible, NZQA will include standards selected by the school. However, other considerations
sometimes mean this is not possible.

Note: Materials Available Date — schools may use this date for your own planning purposes, but the work
must be available for your agreed submission date.

Quick Steps

Log in to the application and select Assessment Plan.

Select the relevant moderation system.

Select the relevant standards from the system M.

Enter the Date Materials Available for each selected standard, if required.
Save the selected standards in the system.

Repeat for all relevant systems.

Enter a comment (optional).

Select Submit Plan to submit to NZQA.

© N o Ok~ b=

Common Features

You can modify the Assessment Plan tables and customise them to your personal requirements.
See the following sections under Common Features:
o Table Options: explains the available menu options.

e Customize a Table: for how to add/remove columns, change the default sort order.

e Export Data from a Table: for how to export the data in the plan.
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Complete and Submit a Plan

Role required:

Moderation Processor (General Security User) can complete standard choices and save notes in the
comment box.

Moderation Authoriser (High Security User) to submit the assessment plan

To complete and submit an assessment plan

I. Log in to the application and select Assessment Plan.
2. Select the Yes radio button, if you are assessing NZQA standards in the next year.
3. To select standards, either:

e Choose the Select Standards link (to view all standards), or

e Select the link to an individual system from the summary table.

2019 Assessment Plan

Waikato Institute of Technology (6019) B e Dot ot Nov-2017 23:59:00

« Assessing NZQA managed standards in 2019 :
| Submit Plan

No

¥ you 6 T assscing ay NZOA tandats ntheupcomng year he no ke krmction s oot | MUAAL

Comments.

¥ you have any overall comments relating to the pian, e g standards you will be assessing in the upcoming year that were not assessed this year (schools only), please enter them here

Enter any comments here

Date Last

NZQA Moderation System ek Materials

Selected

Available

4. Select individual standards, as required (see the Select Standards section of this guide) for all
relevant systems.

5. As you save your selections the Summary table updates with the:
e number of standards selected within the system

e ‘latest’ materials available date, if entered for standards.

Summary
Vew v @iExcel . CSV Detach
%o
Date Last
NZQA Moderation System Sahdarss | Materials
Available
Accounting o
‘Accounting (Middie Level] 1]
16-Aug 2018
= o
Art History ']
Biology (Human Biology) 3
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Complete and submit an assessment plan, continued

6. Add a comment (optional)

The comment will be visible to the NZQA staff member responsible for confirming your organisation’s
moderation plan. The comment field takes a maximum of 250 characters.

Note: Comments can be added to the comment field by all users.
Enter your comment and select the Save button below the comment field.
Schools: Use the comment box to suggest standards that you cannot select in your assessment plan.

7. Select Submit Plan, when all standards are selected, and the plan is ready to submit.

8. A warning message will display, select Yes to submit the plan to NZQA.

- Following submission (or the due date for school plans) the plan will be locked (read only).

Submit a Nil Assessment Plan

TEOs who are not assessing any NZQA managed standards in the upcoming year should submit a Nil
plan.

Submit a Nil assessment plan (TEOs only)

I. Log in to the application and select Assessment Plan.
2. Select the No radio button, if you are NOT assessing NZQA standards in the next year.

3. Add a comment (optional). The comment will be visible to the NZQA staff member responsible for
confirming your organisation’s moderation plan. The comments field takes a maximum of 250
characters.

4. Select Submit Nil Plan, if the plan is ready to submit.

2019 Assessment Plan

Waikato Institute of Technology (6019) s B e ST 0T RS

« Assessing NZQA managed standards in 2019 :

Yes

° No
¥ you 00 NOT ssessingany NZQA standrs it pcomingyaa the no At lormation s rered. [AALANN

Comments

¥ you have any overall comments relating to the plan, e.g. standards you will be assessing in the upcoming year that were not assessed this year (schools only), please enter them here

5. A confirmation message will appear - select Yes to submit the Nil plan to NZQA.

- Following submission, the plan will be locked (read only).
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Selecting standards

Role required: Moderation Processor (General Security User), Moderation Authoriser (High Security User)

To select standards

1. Select the standard (tick) - Selection checkbox.
2. Add the Date Materials Available (optional for schools):
e choose the date from the calendar

e or, enter the date in the format: dd/mm/yyyy.

[cancer ] save | ERTINERTY -

Select Standards
. TEOS
o select standards being assessed in next academic year
«© enter the date by which materials will be available for moderation
- Schools
» select standards you are proposing for moderation
= materials available date is optional, but will help with planning

Enter system name or standard number to search:

System name:
Standard Q

Biology (/Human Biology)
View v @iExcel ) CSV =" Detach

°

6314 Complete an investigation into the ecological niche of a plant species, .. 3 Y

6315 Complete an investigation into the ecological niche of an animal speci... 3 te

90925  Canry oul a practical investigation in a biological context, with direction 1 5

90026  Report on a biological issue 1 [
2

gurEraEtical vestgation in a biology context, with supervision ) '-
Analyse the biological validity of information presented 1o the public t
& L of piants or animals to their

91158  Investigate a pattem in an ecological community, with supervision

a1 s o
s 15 o owom
s owow oo

91160  Investigate biological material at the microscopic level

91601  Carry out a practical investigation in a biological context, with guidance

W oW M 2B M B

w @ NN

91602 Integrale biological knowledge to develop an informed response o a s
el s e o ® 7w B oW 4

Note: schools may use this date for your own planning purposes, but the work must be available for your
agreed submission date.

3. Continue selecting standards for this system, as appropriate.
4. Save your selections using:

e Save - to save without closing the window.

e Save and Exit - to save and return to the plan overview.

Note: System Name

The NZQA Moderation System name that appears at the top of the list, on the Select Standards window,
defaults to that for the first standard on the list. So, if you open a:

e System - then it is the system name

e all standards (i.e. use the Select Standards link) — it displays the system for the first standard in the
list and may change if the standards are re-ordered or filtered.
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Finding a specific standard

Use the Search function to quickly find an individual standard or all standards in a system.

Search for a standard

I.  Use the Select Standards link (for all standards) or open an individual system:

Generate Assessment Plan Standards
[ save and ex Ji8

Select Standards
- TEOS
o select standards being assessed in next academic year.
o enter the date by which materials will be available for moderation
« Schools
o select standards you are proposing for moderation
o materials available date is optional, but will help with planning

Enter system name or standard number to search: ] g
S

ystem name: @,

Standard Q
Core Skills
View v [38 Excel ) csv Detach

/\/\_ré/

2. Click the search icon ~* beside:
e System name — to search for all the standards within a moderation system.

e Standard — to search for a specific standard
3. Search for the standards.

Note: You can also search for a standard by opening any of the systems in the Summary panel.

To search Then...
for...
All standards e Type the first few letters of the name of the moderation system.
within a system
y e Select Search.
e Select the required system from the result list.
¢ Click OK to return to the main search screen.
4= Enter search criteria here ... Search ——
223 Technology
130 Technology - Design and Visual Communication
260 [mctnoogy-ogtaiectnobges |
Select the required system
Ok\
A specific e Type the exact standard number, then Search.
standard .
e Select the standard, then OK to return to the main search screen.
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Search for a standard

Advanced
Search

name:
e e.g. ‘Contains: Design’, returns:
- Graphics and Design Technology
- Technology — Design and Visual Communication

e Use the advanced search feature to find a system when you are unsure of the

4. The Select Standard page updates with all the standards that match the search criteria.

e Example: Search for standard: 91080

lechnology - Digital lechnologies

View v [@BExcel ) CSV E Detach

e

Standard g Date Materials
Standard Title Level Avaiabla

91080 Demonstrate understanding of the common components of basic digit...
« " »

Submitted Plans

Once the plan has been submitted it will be locked (read-only). If you require changes to your plan after you
have submitted it please contact your School Relationship Manager or Moderation Support person.

Locked Plans

Example:

A plan will be locked when:

e it is submitted by the school or TEO

e the plan submission date is passed (schools only).
The message is updated when:

¢ the moderation plan is available, or

e an exemption, or Nil plan status is confirmed for a TEO.

2019 Assessment Plan
ACG Parnell College (2085)

« Assessing NZQA managed standards in 2019 :

Assessment Plan locked: 01-Nov-2017 23:59:00 Provider can no longer make changes.

29-Aug-2018
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Moderation Plan

Overview

The Moderation Plan will become available when NZQA has selected the standards for moderation. The
timing may vary according to the type of provider and your moderation submission date.

View Previous/ Next Plan

At certain times of the year, and depending on your submission date, you may have two moderation
plans available.

Use the year drop-down to change between plans.

2018 Moderation
« Tararua College (235)

<- !our 2019 moderation plan is now available. >
« Create or

o select the standard and choose Edit Submission’ to record submission details, assessor judgements and attach evidence

« Submit to NZQA
o select a standard and choose "Submit’ to submit to NZQA, OR choose ‘Submit All' to submit all standards that are 'Ready to Submit’

Ref : AMP-1801711
Final Date for Moderation Submission:14-Apr-2018

o to view the contents of the submission after submitting select the standard and choose View Submission’
© submissions cannot be edited once they have been submitted
+ Query or Appeal a Moderation Report
© you can only submit a query or appeal while the report status is Provisional’
o if the materials were originally submitted physically you will be able to upload them to facilitate the appeal

Select Moderation Plan Year : 2018

Actions v View v 09 Excel CSV () Print ¥ lﬂ « Detach

Show/hide explanatory text

The explanatory text at the top of the page can be hidden to increase the visible area of the screen. The
expand/contact icon is located beside your organisation name.

Text section hidden - click to expand.

Text section expanded — click to hide.

Common Features

You can modify the Moderation Plan table and customise it to your personal requirements.
See the following sections under Common Features:
e Table Options: explains the available menu options

e Customize a Table: for how to add/remove columns, change the default column and sort order

o Export Data from a Table: for how to export the data in the plan
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Make a Moderation Submission

Quick Steps
1. Log in to the application and select Moderation.
2. Select the required standard.
3. Complete the Submission Details and Assessment Task sections.
e For a digital submission:
o Enteralink (URL, username and password (if required for the moderator to access the
materials), OR
o Upload digital materials for the task.
4. Save the submission.
5. Add Learners: enter a grade for each learner, and comments as appropriate.

e For a digital submission:

o upload digital materials (if not submitting by URL, as above)
Save, and update status to Ready to Submit.
Submit the standard to NZQA for moderation (authorisers only).

If you selected Physical submission you should receive an email containing the moderator’'s address
within 5 working days. Forward the materials to the moderator as soon as possible.

CREATE A SUBMISSION FOR A STANDARD
Role required: Moderation Processer or Moderation Authoriser (High Security User)

To create a submission for a standard

I. Log in to the application and select Moderation.

2. CHECK you have the correct plan year selected.

. . Select Moderation Plan Year | 2018 ||
e Change the year in the Select Moderation Plan Year !

field, if required.
3. Select the relevant standard.

4. Open the Actions menu (from the menu or ‘right-click’ on the selected standard) and select Edit
Submission.

View v 0 Excel ) Csv = Print E Detach

Submit Al

¥ Submit =
I BZ View Submssion Standard Title NZQA Mod. System

(7 gment complex procedures to develop a relational... Technology - Digital Technolo
! B2 \ew Report Cirkv Tonstrate knowledge of practices and strategies to.. Home Economics
91431 3 Analyse aspects of a contemporary geographic issue  Geography
9681 3 Contribute within a team or group which has an objective Core Skills
26627 1 Use measurement to solve problems Numeracy
11899 1 Participate in a leisure activity, in a supported leamning... Supported Leamning
9101 |2 |Procuce a selecton of rafled and controledwrng  [Engish | |
91451 3 Systematically clarify ideas using drawing informed by ... Visual Arts 1-4
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Create a submission for a standard, continued

5. Complete the Submission Details section:

. Edit submission
e Submission Type
.. . e . . Biology (/Human Biology) - Level 2 - 91155
- Dlg |ta| - If S u bmlttl ng materlals On-l I ne Demonstrate understanding of adaptation of plants or animais to their way of life

— Physical - if submitting materials by courier. Seomisinion Dt
Submission Type
e language [ ke e s s ;

— English - default Link
— Te Reo Maori or ‘Other’ — choose the appropriate
value.
° VerSIOf) Username Password
— defaults to the latest version of the standard, L.a?gﬁ’a_?f S g
update if a different version was assessed. Engish
Version”
6. Complete the Assessment Materials section: = . )
Assessment Materials
° Source Source”
— the source of the assessment task.
Modified
e Modified = the sssessme
— Yes - if the assessment task was modified (other Activiy
than context) before use. S

- NO = |f the assessment taSk was Uandified Contact - additional to main/authoriser contact
(other than context). e

7. If making a digital submission, either:
e Enter a cloud storage link
¢ Include a username and password, if needed for the moderator to access the files.
Or
o Attach the assessment task files to the submission, in the Activity section:
— Select Browse
— Find the file you want to upload, select it then click Open.
— Repeat as required.

8. Contact — additional to main/authoriser contact - optional
Enter an additional email address to also receive notification when the moderation report is available.
The Principal’s Nominee in a school and Tertiary Moderation Liaison people are notified
automatically.

See: Moderation Submission Tips and Appendix D: File Management & Digital Submissions for
additional information on making digital submissions.
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Enter learner grades and upload materials

Role required: Moderation Processer or Moderation Authoriser (High Security User)

To enter learner grades and upload materials

Notes:
e Complete the Submission Details and Assessment Task sections (above), before adding
learners.
e Enter alearner grade for ALL learners that you are submitting evidence for.

I. Select Add Learner.
2. Enter the details for the learner.

NZQA External Moderation
AdiPLearner

e [ earner Identifier — an identifier is

automatically assigned (Learner A-H). History - Level 3 - 91437

e Label any physical materials being submitted

with the matching identifier.

e Grade - select the learner’s grade from the Glra'de-

list of values (mandatory). 5
)
e Comment — an optional comment on the e

grade awarded, or to note if evidence applies Optonal comment reated to grade awarded
to more than one learner.

o  Group work identifier — use this option to
identify an individual in a group work. Use a
description (red shirt) not the learner’'s name.

3. Ifthis is a digital submission and you have not
included a link, then attach the learner evidence:
e Select Browse...
e Find the file you want to upload, select it then
click Open.
o Repeat as required.

4. To add more learners, click the Add next button,

and repeat StepS 2 & 3 | Cancel || Save and Exil|
5. Select Save and Exit, when all learner grades

are added. ‘

e As each learner is added the summary table Learner Evidence & Assessor Judgments \

(on the Edit Submission window) is updated. - .
e From the summary table, you can: m

— view the attached evidence : : ' :: _

— open and edit the learner record, c N y

— delete the entire record. A= i

6. When the standard is ready for submission select
Ready to Submit.
e The status of the standard is now ‘Submission
- Ready to Submit’
e The standard remains editable until it is
submitted.

| Cancel || Ready to Submit H Add Learner || Save and Exit | m

Cancel Submission

7. At any stage or preparing a submission it can be cancelled before submitting to NZQA by selecting
Cancel Submission. This will set the status of the standard back to Submission — Not Started.
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Submit one or more standards to NZQA

Role required: Moderation Authoriser (High Security User).

To submit a standard for moderation

I. Log in to the application and select Moderation.
2. Review standards where the status is ‘Submission - Ready to Submit’.
Check:
¢ The Submission Details and Assessment Task sections are complete.
¢ Alearner grade is entered for ALL learners that you are submitting evidence for.
¢ Digital submissions only:
o A Link (URL) is included with a username and password if required,
OR

o Atleast one document/file is uploaded for the Assessment task and each Student.

3. Submit the standard(s) for moderation.
e For one standard:
o Select the standard and open the action menu (right-click).

o Select Submit.

o Displays a confirmation message NZQA External Moderation

for the standard: You are about to submit standard 94386 to HZQA for moderation. Are you sure?

o Select Yes. m

e For multiple standards:
o Note: this action submits ALL standards with status ‘Ready to Submit’
o Select a standard and open the action menu (right-click).
o Select Submit All.

o Displays a confirmation message NZQA External Moderation

fOl’ the StandardS ¥ou are about to submit multiple standards to NZGA for moderation. Are you sure?

o Select Yes. m

Result:
e The standards are submitted to NZQA for moderation.
e The status of the submitted standards changes to ‘Submission — Submitted’

e The submitted standards are no longer editable.

See: Moderation Submission Tips for how to:

¢ Respond to submission error messages.
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Submission Tips

Deleting an attached document

If you've uploaded the wrong document for a:

Task: Task/Activity
e Select Delete documents to open the Delete Choose File | No fie chosen
window. 8 _

e Select Delete " to delete the file.

D;I;teidocumeﬁt:

Learner:

e Select Edit 7 for the relevant learner on the

summary table. INZQA External Moderation
e Select Delete documents to open the Delete Document name | Document
window. MOD_01_Reques... B MOD_0 )

e Select Delete o to delete the file.

Submitting a link

Files stored in a cloud storage system (e.g. Google Drive, SharePoint) can easily be submitted by
providing a share link or URL.

Ensure that:

¢ the files relevant to the standard are organised so that the assessment task and work for each of the
students is readily identifiable by the moderator.

e the share rights are set so the moderator can directly access the materials. For example:
o Google Drive set to “Anyone with the link”.
Note: Files are secure behind both the organisation user login and the moderator login.

1. Enter the link/URL into the Link field in the Submission Details section

2. Ensure a username and password are included, if needed to access the files.

(Link A
If you are uploading files then attach them under Assessment Task & Learner Evidence below
If you want to submit a link (URL) to the files then enter it here:

| Enter link/url here
If the link above requires a username or password to access the files, please enter them here

Username Password

Enter a temparary user name here Enter a temporary password (if required)

IManAiana

3. Ensure grades are entered in the application for ALL students. If a grade is not entered via the
application the moderation result cannot be recorded for that student.
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Removing access to materials

NZQA access to the materials is required if you wish to query or appeal the report.

Once the moderation is complete and the report becomes final, access to the materials can be removed.

Submission Error Messages

The following are common validation error messages that occur when making a moderation submission,
and what to do about them:

Message Action
At least one learner must be Add Learner to create a learner record. Ensure you create a
created. Please try again. record for ALL the learners you are submitting evidence for.

See: Enter learner grades and upload materials

For digital submission Check there is either:
You must enter a url OR upload - alink (URL) entered in the Link field
files for assessment task and
. . OR
learner evidence before submitting
this standard - avalid file uploaded for:

o the assessment task
o at least one learner.

Ensure you create a record and enter a grade for ALL the
learners you are submitting evidence for.

Standard (number) not ready to Check there is at least one learner record created for the
submit. Please enter results before | submission.
submitting.

Check the status is ‘Submission - Ready to Submit’.
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Moderation Reports

Moderation Report Dates and Statuses

The following table provides information on how the status and report due date change according to the
progress of the submission and report.

When the ... Status changes to ...
PN/Mod Liaison submits online. Submission - Submitted
moderator requests physical materials. Report — Pending Material
moderator accepts the submission (digital submission OK, or physical Report - In Progress

materials received).

moderator completes the report. Report - Provisional
provisional period expires and no appeal has been received. Report - Final

appeal is accepted. Appeal — In progress
appeal is completed. Report - Final (Appeal)

Quick Steps — View, Print and Query

1. Log in to the application and select Moderation.
2. Select the required standard:
e The status must be Report- Provisional, Report-Final or Report-Final (Appeal)
3. Right-click on the selected standard.
4. Select the required menu option to view or print the report.
5. To query a report (Moderation Plan only):
e Select View Report, then Query Report.
e Enter your query and Submit.
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View a Moderation Report

There are two options for viewing a report.

e Recently published reports (provisional) and final reports for the current and previous year can be

viewed from the Moderation Plan page.

¢ Allfinal reports including reports more than two years old can be viewed from the Moderation

History page.
Only reports in the following statuses can be viewed:
e Report-Provisional
e Report-Final
¢ Report-Final (Appeal)

Once final, reports will remain available indefinitely.

View a moderation report — Moderation Plan View

Role required: any person with access to the application can view reports.

I. Log in to the application and select Moderation
2. Select (click) on the required standard, then right-click to access the menu.

2018 Moderation

ABG College (1234)

aiong v tAme v [ Fwcel 0 CSV G Prm (¥ | Detach

Ref : AMP.1900844
Firal Date for Moderation £

Select Moder:

Standard - Date Mat. | Submissig
NZOA Mod. System Avaiiable | Type | SUbmited Date Outcome Repart (Due) Date

A0RGE Englizh Digital Ofi-Mar. 2018 Consistent O7-Mar- 2018 - Final

91106 _ English — Digital  |31-0cl-2017 | Consistent 03-Now-2017 - Final

91350 2 Technology i Digital 06-Mar-2018 05-Mar-2016 Reporl - Final (Appeal)

Subme

227456 3 Maori Parforming A Digital Ofi-Mar-2018 Kaore and kia orte 06-Mar-2018 RFeport - Final (Appeal)
®E e Submizs

27009 2 Fnglish | anguage | ®= " SUETIESE Prysical  13-Nov-2017 05-Nec-2017 Repart - In Progress
[# Edtsuemizsion CreE .

fuieleli] 2 Socology Digital 06-Mar-2018 2T-Mar-2018 Reporl - In Frogress

a1447 3 Visual Arts 1-4 AE lew Reouil il Digital Ofi-Mar-2018 FT-Mar2015 Report - Provisional

41537 3 Chinesa f= Fris Repart Digital  Of-Mar-?018 FT-Mar-2018 Report - Provisional

91340 2 Technology - Design and Visual Co... Digital 06-Mar-2018 27-Mar-2018 Reporl - Provisional

3. Select View Report from the menu.
o The overview section of the report is displayed
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View a moderation report, continued

4. Drill down to each section, as required.

e Assessor Decisions: The outcome
of the moderation. To see the learner
grades, select View Details.

e Assessment Task: The outcome for
the assessment task, if moderated.
To see the detail of any issues and
recommendations, select View
Details.

o Issues: This section only displays if
one or more issues were identified
during moderation.

e Query: This section only displays if
your organisation has sent in a query
about this moderation report. To see
query details, select View Details.

e Appeal: This section only displays if
your organisation has appealed this
moderation report.

In this example, no appeal has been
created.

5. Select Download Report to generate a
printable version of the report.

6. Select Cancel to close the report.

| NZQA External Moderation
2018 Moderation Report

ABC College (1234)

Technology - Design and Visual Communication - Level 2 - 91342
Develop a product design through graphics practice

Assessor Decisions

Overall, sssessor decisions for the sample of work provided are consistent with the standard.

Hide Details

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Phasellus in soliicitudin lectus, sed laoreet augue. Nam ut
convallis nulla. Aenean vestibulum, nisl non ullamcorper malesuada, ex arcu sagittis sapien, sed auctor erat elit eget
lectus. Morbi volutpat nibh leo, hendrerit blandit odio iaculis utricies. Duis sagittis consequat sem sed aliquet. Quisque
dignissim ut sem ut finibus. Duis tempor massa sit amet erat lacinia scelerisgue. Aliguam non mi tempor, mollis ex vel,
pharetra magna. Mauris et suscipit nulla. Vivamus ligula lectus, lobortis vel malesuada ac, auctor sit amet magna.

Assessor Moderator View

A 0 A Click to view
comments for

B A A 53 individual learners

c N N (54

D E M &

Assessment Task View Details

Assessment materials require modification

Lorem ipsum dolor sit amet, c i elit. Phasellus in solicitudin lectus, sed laoreet augue. Nam ut

convallis nulla. Aenean vestibulum, nisl non ullamcorper malesuada, ex arcu sagittis sapien, sed auctor erat elit eget
lectus. Morbi volutpat nibh leo, hendrerit blandit odio iaculis ultricies. Duis sagittis consequat sem sed aliguet. Quisque
dignissim ut sem ut finibus. Duis tempor massa sit amet erat lacinia scelerisque. Aliguam non mi tempg g =
pharetra magna. Mauris et suscipit nulla. Vivamus ligula lectus, lobortis vel malesuada ac, auctg Click to s

Query details

Issues
= Publicly available assessment resources have not been appropriately modified. O
=
CQuery The buttons visible View Details

depend on your
role and the status
of the report

A guery has been received for this report.

08-Mar-2018(Report - Provisional)
MOD-1844243

Appeal report || Download Report |

View Learner Details

The assessor and moderator’s grades for the learners
are displayed in a summary table. To view the details

for a specific learner:

NZQA External Moderation

Technology - Design and Visual Communication =

Level 2 - 91342
e Click the View Comments ( & ) icon for that
learner. Learner A
Evidence
o View the Evidence that was uploaded for the Evidence fief be avsiabl i the s originally submited on-ine and s

learner (digital submissions only).

e View assessor and moderator grades and

comments.

Use the <Prev and Next> buttons to move through the

list of learners.

within & months of your organisation’s final submission date

Assessor Grade: M

Moderator Grade: A

Moderator Comment

Vivamus a erat lorem. Sed sodales dolor vitae mattis pharetra. Nunc
tempus felis ut efficitur egestas. Sed commodo vel eros sed fringilla. Donec
at dapibus nulla.

08-Mar-201&Report - Provisional)
MOD-1844243

Cancel | IEH m
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Query a Moderation Report

Use a Query where you're not clear on the meaning of something in the moderation report, to clarify the

decisions and comments following moderation.

You can only submit a query if the status of the report is ‘Report-Provisional’.

Role required: Moderation Processer or Moderation Authoriser (High Security User)

To query a moderation report

1. View the report as above.

2. Select Query report.

3. Type your question in the Query field.
4

Upload any relevant evidence using the
Choose File function.

= Note: Only evidence from the original
submission should be included.

5. Save or submit your query:

e Save to save your query without
submitting it.

e Cancel to return to the report, without
saving the query.

e Submit, then click Yes to send the
query to NZQA.

Geography - Level 1 - 91011

Query”

What is the subject of the query?

Enter query here

Query History

Attach evidence

submission that are relevant
ubmitted to NZQA for

Choose File | No file chosen

Notes

section gets added to the report.

Submitting a query doesn’t change the status of the standard
in the moderation plan. The only difference is that a Query

The Principals’ Nominee or Moderation Liaison will receive an
email notification when the moderator responds to the query.

To view a query, click the View Details link on the moderation
report, then view the questions and responses.

Query Moderation Report

Enghish L

You'll be able to view the
questions and responses in the
Query History section.
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Feedback on moderation reports

When you view a provisional moderation report
there is a Feedback option.

‘ | Feedback || Query report || Appeal report H Download Report | m

This is intended as an opportunity to provide NZQA with feedback
regarding the detail, clarity, and helpfulness of the moderation report. Question 1: Was this report detalled enough?

Response: [ v]

Selecting Feedback will open a pop-up window in which you can
select your responses from the drop-down menu alongside each
question.

Question 2: Is the report clear with what | have to do?
Response: | v‘

Question 3: Was this report helpful?
Response: | v|

£ [

Select Submit to save your responses and close the window.

Appeals

Appeal a Moderation Report

An appeal may be appropriate if you disagree with moderation decisions and/or comments. Before creating
an appeal, you should discuss it with the Principals’ Nominee or Moderation Liaison for your organisation.

If you just want more information or clarification about something in the report, then submitting a query may
be more appropriate.

Note: An appeal must be submitted within 30 working days of the ‘provisional’ moderation report being
published. After this time, the report becomes final.

Quick Steps

1. Log in to the application and select Moderation.
2. Select the required standard.
o The status must be: Report — Provisional.
Right-click on the standard.

Select View Report from the menu.

Select Appeal report.

Enter appeal details and attach evidence (if relevant).
Select Ready to Submit.

Submit the appeal (Management Authoriser only).

© N o bk w

Note: an appeal can only be submitted from the Appeal view, it cannot be submitted from the moderation
plan.
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Prepare Appeal

Role required: Moderation Processer or Moderation Authoriser (High Security User)

To prepare an appeal

e Report-Provisional

Only reports in the following status can be appealed:

I. Select View Report for the relevant
standard from the moderation plan.

2. Select Appeal report.

3. Select Add Issue.

Appeal Moderation Report

|NZQA External Moderation
S 2018 Moderation Report

ABC College (1234)

Core Skills - Level 3 - 1980

Describe, from an employee perspective, ways of dealing with employment relationship problems

Assessor Decisions

Overall, assessor decisions for the sample of work provided are consistent with the standard.

View Details

Assessment Task

Assessment matesials meet the standard.

View Details

18-May-2018(Report - Provisional)
MOD-1882108

Query report |KAppeaI report)| Download Report |
——

Once you've added an
issue, it will display in the

Legal Studies - Level 3 - 27849

7

Attached Documents

Appesi Details details table.
S ¢
lssue|  Description | Material |5 4ion Requested| Edit [Delete
| Reference
1 Learner B should be ac_. Document should r.. Change Leamer B p T

QA External Moderation

Add Issue

Legal Studies - Level 3 - 27849

Issue Details - Issue 2

Descripion "

Moderators comments for Leamer C refer 1o the lack of differing viewpoints relating 1 the

law making process. The modersiors grade was A
Material reference

The document marked Evidence 3 kists five Gifferent viewponts.

Assessment Task

Leamer Evidence

28-Feb-2017 (Report - Provisional)

You can add up to four
issues in the appeal.

Action Requested

Change the leamer's grade fo M

[ome ][ = ]I

MOD- 183208

Cancel | [ Cancet Appeat [ submit

| [ Ready to submt | [ Atach Evisence | [IEZTEENN

The Attach Evidence button only
displays for physical submissions.
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Prepare an appeal, continued

4. For eachissue, include:
e Description: the issue you've identified within the report (up to 1000 characters)

e Material reference: location of the evidence to support the appeal within the assessment materials
(up to 250 characters)

e Action requested: what outcome you are seeking (up to 250 characters).

e Save the issue.

5. Create additional issues, as required, (maximum of four), click the Add next button, and return to
step 3.

6. Evidence required for an appeal will depend on how the original evidence was submitted.

If the original evidence | Then...

was...

uploaded files the appeal moderator will have access to it, it does not need to be re-
loaded.

a link (URL) please ensure the link (and any associated username and password) are

still active so the appeal moderator will have access to the evidence.

physical and the material | v,y may choose to submit the evidence digitally (see below) or you will
has been returned need to return the evidence to NZQA.

physical and the material | g,,mit the appeal and note that the material is still with the moderator
has not ben returned

Note: If the original moderation submission was a physical submission, you can upload digital files of
the material to expedite the appeal process.

e Select Attach Evidence.
— In either the Assessment Task or Learner Evidence sections, select the Browse button.
— Find the file you want to upload, select it then select Open.
— Repeat as required and Save.

Only material orignially submitted for moderation should be included with an appeal. Any
additional material will not be considered for the appeal.

7. Once you have added all the issues and evidence, select Ready to Submit.

e You can still edit an appeal with status ‘Ready to Submit’.
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Submit Appeal

Role required: Moderation Authoriser (High Security User)

To submit an appeal to NZQA

I. Select View Report for the relevant standard on the moderation plan.
Note: the status should be ‘Appeal Ready to Submit’

2. Select Appeal Report.

3. Review the appeal details. Ensure that:
o the issue Description and Action Requested sections contain sufficient detail

e only originally submitted material is
included. Any additional material NZQA External Moderation

will not be considered for the
appeal. Appeal Moderation Report

Core Skills - Level 3 - 1980

Describe, from an employee perspective, ways of dealing with employment relationship problems

4. Save any updated details, as required. AT DR

sical] you have the option to sub
then rlaecr yard to

the appeal. If you
by courier, once

this appeal has been submitted

5. Select Submit. Eaz:
Lorem ipsum dolor sit amet
. . . , consectetur adipiscing elit
¢ A confirmation message showing AT
1 as ante tincidunt, vitae con
the standard number displays. L

ula libero, dictum nec mole
stie non, viverra bibendum [i
gula. Curabitur hendrerit ull

6. Select Yes to submit the appeal to st it ol
NZQA. i e '
e The status of the standard changes
‘ . y Attached Documents
tO Appeal Sme Itted . Select 'Attach Evidence’ fo add or remove documents

Assessment Task

e Once you submit an appeal, you e e
will no longer be able to edit it. P

MOD-1882109 P
‘ Cancel || Cancel Appealﬂ Submit IDReady to Submit || Attach Evidence ‘
Y

What Next?

When the appeal is received, NZQA checks that it meets the appeal criteria:
e Ifitdoesn’t, you will receive a notification that the appeal was declined with the reason why.
o |Ifit does, NZQA will start processing the appeal.

The appeal outcome is recorded in the moderation report.

The Principals’ Nominee or Moderation Liaison is notified when the final report is available.
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Annual Summary

Overview

The annual summary provides an organisational level outcome for National External Moderation of NZQA
managed standards.

Quick Steps

1. Log in to the application and select Annual Summaries.

2. Select the required summary.

3. View online or download and print the summary report.

4. Click the Moderation History link to access the moderation report historical view.

View an Annual Summary

Role required: only users with Moderation Authoriser or Moderation Management View can view the
Annual Summary reports.

To view an annual summary

I. Log in to the application and select Annual Summaries

External Moderation Annual Summaries
ABC College (1234)

Overall Outcome Attachments

2018 Meets the majority of requirements. View

2. Select the required summary from the list and select the View link

Note: To view any documents associated with the summary, such as an action plan, select the
Attachments icon.

3. View the selected summary.

“2018 External Moderation Summary
ABC College (1234)

Overall resutts for National External Moderation
ABC Catege Mieets e magety of he nationsl extems modsralice reaurements ot 2018

e Comment Ovérsl Comment Oversd Camment Ovérak Comment

A wismary of s moderalion resuly and access 10 Niviiual reports for  ABC Colage 5 avabatie o e boderatin sy page

13 Aug 2018
ANS-180104 PrintiDownload

4. Click on the Moderation History link to access the final reports view.

5. Select Download for a printable version of the annual summary.
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Moderation History

Overview

All final reports are available from the Moderation History page, including those for the current and all
previous moderation cycles.

You can select and download multiple reports from the Moderation History page.

Common Features

You can modify the Moderation History table and customise it to your personal requirements.
See the following sections under Common Features:
- Table Options: explains the available menu options
- Customize a Table: for how to add/remove columns, change the default column and sort order

- Export Data from a Table: for how to export the data in the plan

View Historical Moderation Reports

Role required: any person with access to the application can view historical reports.

View Moderation History

I. Log in to the application and select Moderation History.

Moderation History
». ABC College (1234)

Adions = View v [ Excel . CSV (5 Print | Detach

Sys.lem Number Decisions Task

Accounting 91179 Demonstrate understanding of an accounts receivable subsystem for an entity 2 Consistent Report - Final
Accounting 80977 Process financial transactions for a small entity | Consistent 2018 Report - Final
Agricultural... 90918 Carry out a practical agricultural or horticultural investigation 1 Consistent 2018 Report - Final
Art History 91486 Construct an argument based on interpretation of research in art history 3 Consistent 2017 Report - Final
Art History 91020 Explain why selected objects may be considered as art 1 Consistent 2018 Report - Final
Biology {/H... 91153 Carry out a practical investigation in a biology context, with supervision 2 Consistent 2017 Report - Final
Biology {(/H... 91607 Demonstrate understanding of human manipulations of genetic transfer and its biological imglications 3 Consistent 2018 Report - Final
Business 5... 90846 Conduct market research for a new or existing product 2 Consistent 2018 Report - Final
Business 5... 90842 Carry out and review a product-based business activity within a classroom context with direction 1 Consistent 2017 Report - Final
Chemistry 91387 Carry out an investigation in chemistry involving guantitative analysis 3 Consistent 2018 Report - Final
Chemistry 91393 Demonstrate understanding of oxidation-reduction processes 3 Consistent 2017 Report - Final
Chinese 90872 Write a variety of text types in Chinese on areas of most immediate relevance 1 Consistent 2018 Report - Final
Chinese 91535 Interact clearly using spoken Chinese to explore and justify varied ideas and perspectives in different situations 3 Consistent 2017 Report - Final
Classical ... 91202 Demonstrate understanding of a significant event in the classical world 2 Consistent 2017 Report - Final
Claceiral 1< Q13097 Namnnstrata undarctandina of cinnificant idanlnmidias) in tha claceical warld ] Cnncis tant 2N18 Rannart _ Final

You can:

¢ open an individual report to view it, or download single or multiple reports for printing, see:
Download and Print section.

e add ‘Issues’ columns to this view (see: Customize a Table), to easily see any issues raised in the
report..
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Moderation Report — History View

The report view differs slightly from the view available from the Moderation Plan page, however the content
is identical. Collapsed sections can be expanded by clicking the section header.

Moderation Report

ABC College (1234) _

Status: Report - Final

Moderation Report
Date: 11 Jun 2017

Art History - Level 3 - 91488

Construct an argument based on interpretation of research in art history

« Overview

Assessor Decisions

Overall, assessor decisions for the sample of work provided are consistent with the standard.

The assessor judgements are accurate and reveal a clear understanding of the standard's requirements Careful consideration has been given to the evidence and as a consequence
accurate decisions have been awarded consistently

Assessment Task

Assessment materials meet the standard.

* lIssues

+ Assessed Work

~ Assessed wak

v Learner A
v Learner B
~ Learner C
~ Learner D
v LearnerE
v Learner F
v Learner G
~ LearnerH

~ Assessment Materials
~ Appeal
~ Query

~ Submission Details
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Appendix A: Access Rights

Manage User Access

If you need to arrange access to the moderation application for staff, please follow the normal procedure
within your organisation for an Education Sector Logon. (ESL)

An email address is mandatory and must be unique to the user (not shared by any other person who will
also login via ESL). This email is used for verifying identity, not for sending notifications.

The following roles are available for users of the external moderation application.

Secondary MoE Tertiary MoE role Type of access to the moderation application
role
General Security TEO View Only Users have the role of Moderation Viewer, and can:
User - view the moderation plan,

- view moderation reports and results.
Moderation TEO Administration | Users have the role of Moderation Processor, and can:
Process

- enter assessment judgements/grades
- upload material for moderation
- view moderation reports and results

- submit queries about moderation reports.

High Security User

TEO Management
Authoriser

Users have the role of Moderation Authoriser, and can:
- select standards and submit assessment plans

- view moderation plans

- enter assessment judgements/grades

- upload material for moderation

- authorise moderation submissions

- view moderation reports and results

- submit queries about moderation reports

- lodge appeals

- view annual summaries and manage action plans.

Moderation
Management View
Only

TEO Management
View Only

Users have the role of Moderation Management Viewer,
and can:

- view moderation reports and results

- view annual summaries and action plans.
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For TEOs:

The access required is on the following section of the ESL form:

Part 4: Which educational services do you need access to? MoE use

Please see the Education Sector User Account Guide for more information about these services

National Student Index (NSI) [ Read only
(SOMERXISI KX S Y ISSE CETES SR8} [ 1 need to be able to make changes to NSI
| Select only
[ Basic Learner Record User one option
New Zealand Qualifications Authority (NZQA) from these
[] Leamer Details Administrator TEOE
Tertiary Education Organisation Extranet (TEOE) Leamer
[ Learner Results Administrator Record
services
[ TEO Profile View User Select onky
New Zealand Qualifications Authority (NZQA) one option
[J TEO Profile & Application Admin. | from these
Tertiary Education Organisation Extranet (TEOE) TEOE TEO

[[] TEO Management Representative | Profile
services

e [J TEO View Only "m\
—
#New Zealand Qualifications Authority (NZQA) [ TEO Administration Faindi sl

Tertiary Education Organisation Extranet (TEOE) | [[] TEO Management Authoriser TEOEJE:

[J TEO Management View Only services T

Tertiary . sion ——t =
Shared Workspaces [Juser
mmm Commission (TEC) O user

Services for Tertiary Education Organisations [ My organisation submits an SOR
(STEO)
[ My organisation submits an RS20 or EEL return

STEO Tertiary Data Warehouse (TOW) O user
Literacy and Adult Tool Oo [ educator
Te Kete Ipurangi (TKI) All Education Sector users are provisioned with TKI
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Appendix B: Browsers

Supported Browsers

The following browsers are supported by the application:
e Google Chrome 45+
e Mozilla Firefox 31+
e Internet Explorer 11.*
o Safari 8.

The NZQA External Moderation application is supported across a range of browsers, however not all
browsers behave in the same way, and functionality changes over time. If you are experiencing issues with
the application using a particular browser, please try a different one. We have found Mozilla Firefox
provides the best experience when using the application.

If you are using any browser other than those listed, then we cannot guarantee the application will work
correctly.

Incognito Mode

Browsers offer the option of an ‘incognito’ mode where some of the information, such as cookies, that
can cause application issues is not saved between sessions.

You can access incognito mode in:

e Chrome: from the Customize menu > New incognito window (Ctrl+Shift+N)
¢ Firefox: from the Open menu > New Private Window

e |E: from the Tools menu > Safety > InPrivate Browsing (Ctrl+Shift+P)

e Safari: from the File menu > New Private Window (Command-Shift-N)

CLEAR BROWSER HISTORY

It may be necessary to clear your browser history (a.k.a. clearing the cache) if you have encountered an
Oracle error or are having persistent issues with ‘weird behaviour’ in the application. (See: Appendix C:
Oracle Errors).

It is possible with most supported browsers to clear your history without clearing saved passwords, etc.

Always shut down the External Moderation Application before clearing your history.
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Clear browser history - Chrome

1. Select the Customise and control Google Chrome

|

icon at the top of the browser window. s =S
2. Select History from the dropdown list (or Ctrl + H). e
3. Select Clear browsing data.

¢ A new popup displays with a list of the items to

clear.

4. Select: “All time” option, or the period required to get back to

before you first experienced issues with the app. Gl browsing data
5. Check: At

e Browsing History

o Cookies and other site data

e Cached images and files
6. Select Clear data.
7. Close the browser, re-open and try again.

Note: Always clear the history if you encounter an Oracle Internal error using Google Chrome.

Clear browser history - Firefox

I. Click the Open menu icon at the top of the browser window.

2. Depending on the options you have in your browser version, you can either:

e Select: Options. A new tab displays. You may need to click the Privacy
tab to display the options for clearing your history. Select Clear your

recent history.

e Select: History > Clear recent history from the dropdown list.

3. Enter atime range: “Everything” or the period required to get back to before

you first experienced issues with the app.

4. Check:
e Cookies
e Cache

e Hosted app data
5. Select Clear Now.

6. Close the browser, re-open and try again.

Clear Recent History et
Timerangeto clear: | Last Four Hours 'l
(] Details

Browsing & Download History
[] Form & Search History
v] Cookies
[¥] Cache
Active Logins
Offline Website Data
Site Preferences -~
Clear Now Cancel ‘

.......

€) SignimtoSync

Note: It's usually Ok just to close the browser if using Firefox and start again. Clear the history if the error

persists.

Clear browser history - Internet Explorer (IE)
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I. Select

window

Delete....
3. Check:

again.

options , at the top of the browser

2. Under Browsing history select

e Temporary Internet files and
website files

e Cookies and website data.
4. Select Delete.

5. Close the browser, re-open and try

#*  Tools > Internet

Internet Options » e

(9 [

General | privacy | Content | Connections | Programs [ Advanced

Home page

? To create home page tabs, type each address on its own line.
& |

http://qanet.nzqa.govt.nz/

[ usecurrent | [ usedefauit ] [ usenew tab

Startup
Start with tabs from the last session
@ Start with home page
Tabs

ges are displayed in tabs.

form information.

[7] Delete browsing history on exit

@  Some settinas are managed by your system administrator.

Delete temporary files, history, cookies, saved passwords, and web

[oc J[ concel [

==

Delete Browsing History

Awiy]

Preserve Favorites website data
t enable your favorite

tepoGatesasfles tha
websitesbeETER preferences and dsplay fastErs

[V] Temporary Internet files and website files
Copies of webpages, images, and media that are saved for faster
viewing.

[¥] Cookies and website data
Files or databases stored on your computer by websites to save
preferences or mprove website performance.

List of websi

["] pownload History i
List of files you have downloaded. fl

[C] Form data
Saved information that you have typed into forms.

["] Passwords
Saved passwords that are automatically filed in when you sign in
to a website you've previously visited.

[C] Tracking Protection, ActiveX Filtering and Do Not Track
Alist of websites exduded from filtering, data used by Tracking
Protection to detect where sites might automatically be sharing details
about your visit, and exceptions to Do Not Track requests.

FORTTO—

Notes:

o Always clear the history if you encounter an Oracle Error while using Internet Explorer.

e If you select the option to ‘Delete history on exit’ then the cache will automatically be cleared
every-time you close the browser.

Clear browser history — Safari

Q w O f

General Tabs Autofill Passwords Search Security Privacy Notifications Extensions Advanced

Bonjour:

Style sheet
Default encoding

Proxies:

1. Enable the Develop menu:
- Choose: Preferences > Advanced

- Close out of Preferences.

Advanced

.

Smart Search Field: £ Show full website address

Accessibility: £ Never use font sizes smaller than 10 g

Press Tab to highlight each item on a webpage
Option - Tab highlights each item

Include Bonjour in the Bookmarks menu
Include Bonjour in the Favorites bar

Internet plug-ins: B Stop plug-ins to save power

None Selected ]
Western (150 Latin 1) (V]

Change Settings

[ €3 Show Develop menu in menu bar ]

- Check: ‘Show Develop menu in menu bar’

Open Page With
User Agent

Retina MacBook Pro
Enter Responsive Design Mode

Connect Web Inspector
Show Error Console
Show Page Source
Show Page Resources

Show Snippet Editor
Show Extension Builder

Start Timeline Recording

Empty Caches

Disable Images

Disable Styles

Disable JavaScript

Disable Extensions

Disable Site-specific Hacks
Disable Local File Restrictions
Disable Cross-Origin Restrictions

Allow JavaScript from Smart Search Field
Treat SHA-1 Certificates as Insecure

2. From the Develop menu select ‘Empty Caches’.
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Appendix C: Oracle Errors

BROWSER ‘BACK’ BUTTON

Many of the issues schools/TEOs have experienced with the NZQA External Moderation application result
from using the browser back button to exit a screen.

PLEASE DO NOT use the browser ‘Back’ button (or other browser navigation) to exit a screen in the
application — always use the applications’ navigation (e.g. NZQA Logo or Home symbol) or button options
(i.e.Exit, Cancel).

Using the browser Back button is the main cause of the ‘Oracle Internal Error’ and other unfriendly screen
behaviour such as:

¢ duplicated columns in tables
o multiple banners
e ‘missing’ fields in Edit screens.

If any of the above occur you can:
¢ Use the Refresh function to restore a table with duplicated columns,
Or:
¢ Exit the External Moderation application.
¢ Delete the browser cache, cookies, and history.
e Close the browser completely (all tabs) and re-open.

¢ Login again to continue working.
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Appendix D: File Management & Digital Submissions

MANAGING FILES STORED IN THE CLOUD OR ON YOUTUBE

To submit files stored in the Cloud

Files stored in a cloud storage system (e.g. Google Drive, SharePoint) can easily be submitted by
providing a share link or URL.

Ensure that:

¢ the files relevant to the standard are organised so that the assessment task and work for each of the
students is readily identifiable by the moderator.

o the share rights are set so the moderator can directly access the materials. For example:
o Google Drive: “Anyone with the link”.

Submit files stored on YouTube
In this situation:

e provide a URL for each student (by pasting into a document)
o if all the URLs are in a single document then clearly identify each link, and upload the document, or
e you can upload a separate document for each student, or

Don’t forget to upload your assessment task/link when preparing your submission.

FILE SIZES AND TYPES

Accepted File Sizes

File sizes are limited by the External Moderation Application. Large files, especially videos, may impact
on your experience for reasons other than platform limitations.

Our experience indicates that file sizes of up to 30MB will enable an acceptable experience of submitting
files.

If you get an “Oracle Internal Error” then the file size is too large.

This is best resolved by uploading moderation materials to cloud storage and then save the share link
(URL) in the submission as outlines above.

If you get an error, you should also clear your browser cache, cookies and history.

There are several reasons why smaller files are more manageable:

e depending on where you are working from, large files typically take a long time to upload; the upload
may fail if the digital moderation application times out (this is set to occur after 15 minutes if you do
not confirm your intention to continue)

¢ they may use more storage space in your school system than you intend

¢ depending on where moderators are working from, large files typically take a long time to download
and could also be subject to timeout.

We are happy to discuss options for managing large files on a case-by-case basis. Please contact
modsupport@nzaga.govt.nz or (04) 463-3240, to do this.
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Accepted File types

The following file types are accepted:

Files types Preferred format Formats also accepted

Documents pdf doc, docx, odt, xls, xIsx, csv, ods, ppt, pptx, odp
Images insert into a pdf documents

Audio mp3, wav wmz

Multi-media/video mp4, avi, mov

If you are using other formats, moderators may not be able to read your files. Please contact
modsupport@nzga.govt.nz or (04) 463-3240 to discuss options if you are using file types other than
those mentioned.

MANAGING VIDEO FILES

Video files are best uploaded to cloud storage and the share link saved in the moderation submission with
the share permissions set so that the moderator can directly access the materials for moderation.

Files stored in the cloud should be clearly identified and all learner grades still need to be entered into the
submission.

To reduce file size

Reduce the size of files by:
e adjusting the recording settings on your video camera
e converting the file to another file type

Video cameras, by default, are usually set to ‘auto’. The settings for the recording size and the frame rate
are likely to be high and this creates large files (>200MB). There are many YouTube videos and other
online guides on how to adjust your camera settings to create smaller video files.

Convert to an accepted format

The accepted video file types are: mp4, avi or mov.

There are numerous applications available to convert video files from one format to another. See the
Useful Resources below. Many applications also have an export function which allows you to export files
in a common format.

Converting to another format may also compress the file.

Other Useful Resources

The following links provide more information on managing file formats.

http://www.zamzar.com/fileformats/

This website categorises many different file formats for documents, images, music, and video files,
among others. It also provides an online conversion facility.

https://www.lifewire.com/quide-to-camcorder-video-file-formats-487992

Provides a useful guide to camcorder video file formats.
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